
Chapter 1: Getting Started 
with Flash 9

In This Chapter
� Creating and saving new documents

� Getting familiar with the workspace and tools

� Managing your workspace and panels

� Thinking about FLA and SWF file formats

� Introducing Flash Player 9

� Understanding the publishing process

Welcome to the world of Flash, one of today’s hottest applications for
creating eye-catching motion graphics featuring sound, video, and

visual effects. In this chapter, you explore the whole process, from basic
graphics creation and animation to complex effects and user interaction.

Creating Your First Flash Document
To get started, you’re going to create a new blank Flash document and set
up your workspace. You can create a new document in two ways:

✦ From the Start page, choose Flash File (ActionScript 3.0) under the
Create New column.

✦ Choose File➪New Flash File➪(ActionScript 3.0).

Your new document is created, and the workspace appears. Before you get
to work, you need to specify some important settings, such as width and
height, for your file by using the Document Properties dialog box.

To open the Document Property inspector dialog box, choose Modify➪
Document and set the following options:

✦ Title: This is simply the title of your new Flash file. Although you can
leave this blank, it’s typically a good idea to name it from the beginning
using a short but intuitive name, such as Home Page.
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✦ Description: This is optional and can contain descriptive text about
your file, including a summary, last revision date, or any info you feel
may be helpful later. This information is only visible when viewing
Document Property in the authoring environment and has no impact on
the final movie.

✦ Frames Per Second: Because Flash files behave like movies, the frame
rate is an important setting that impacts the performance of your movie.
The default setting of 12fps should do fine.

✦ Dimensions: The width and height set here determine the size of your
stage and in turn, the visible area of your final movie. For now, leave the
default setting of 550 pixels wide by 400 pixels in height.

✦ Background Color: Click the swatch to pick a background color for your
stage from the Web-safe color panel. This also sets the background color
of any Web pages created by Flash if and when you publish your movie
to the Web.

When you’re done fine-tuning your document Property, choose OK.

Getting Familiar with the Workspace
The most prominent item you’ll notice is dead center on the screen: the
stage. The stage is where the action happens — where you draw, build, or
import graphics, create text, and construct layouts.

The grey area surrounding the stage is your work area. Items placed here
aren’t visible in your final movie because they’re outside the bounds of the
stage. However, it helps to think of this area as backstage — where text, art-
work, and images can make their entrance or exit or be placed until they’re
ready to appear in your movie.

The Tools panel
What CS application would be complete without a fancy toolbar? Flash has a
comprehensive set of tools for just about any drawing task you’ll need to
wrap your hands around. Table 1-1 gives you a rundown and description of
the tools you’ll find. The Tools panel, shown in Figure 1-1, has been
redesigned to make your work area flow better. A double arrow at the top
lets you toggle between a single column and double column to maximize
your work area.
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Table 1-1 The Tools Panel
Tool Description

Selection tool Selects and moves objects on the stage and work area

Subselection tool Selects and moves specific points on a path or shape

Free Transform tool Changes the dimensions, rotation, or proportions of an object

Gradient Transform tool Changes the size, intensity, and direction of a gradient fill

Lasso tool Creates freehand selections around one or more points

Pen tool Creates accurate , point-by-point straight and curved paths

Add Anchor Point Adds anchor points along an existing path

Delete Anchor Point Removes anchor points from an existing path

Convert Anchor Point Changes the curve orientation of an existing point

Text tool Creates text on the stage

Line tool Draws straight lines

Shape tools Creates rectangular, oval, or multisided shapes on the stage

Pencil tool Draws freehand paths

Brush tool Draws broad, freehand fill areas

Ink Bottle Applies or modifies the stroke color and style of a shape or path

Paint Bucket Applies or modifies the fill color of an area

Eyedropper Samples the color Property from an object

Eraser Erases parts of a fill or path

Hand Repositions the stage and work area within the workspace

Zoom Zooms in or out of a selected area of the stage

Figure 1-1:
Use the
double
arrows on
top of the
new Flash
CS3 Tools
panel to
switch
between
double and
single
column
views.
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The timeline
Above your stage sits the timeline, where you bring your artwork to life
through animation. The timeline is broken out into layers; new documents
automatically contain one new layer labeled Layer 1. Each layer on the time-
line is composed of frames that span horizontally from left to right, each one
representing a point in time, just like frames in a movie reel (see Figure 1-2).

The Property inspector
Sitting at the bottom of your workspace, the Property inspector allows you
to get (and set) attributes (such as height and width) for a selected item on
the stage or work area. When nothing is selected, the Property inspector,
shown in Figure 1-3, shows your document properties.

You can modify your document Property at any time from the Property
inspector when no items on the stage are selected or by choosing Modify➪
Document.

Panels (right side)
The many panels included in Flash give you total control over most aspects
of your movie, from creating and managing colors to exploring the structure
of your project.

The default workspace launches with three panels: the Color, Swatches, and
Library panels.

You’ll want to get familiar with panel behaviors and features so that you can
manage their appearance and make organizing your workspace a snap.

Figure 1-2:
The timeline
is com-
posed of
frames,
each one
represent-
ing a point
in time
moving left
to right.
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The panel group
The panel group sits on the right of the workspace and features multiple
panels docked, or grouped, together. In the default workspace, the Color and
Swatches panels are docked together.

The panel group can’t be freely repositioned in the workspace. However, it
can be resized or collapsed down to icon view using the double arrows
found in its upper-right corner).

You can undock panels from the panel group. Simply click and drag a panel
away from the group by its title tab. To dock a panel into the group, drag it
into the panel group.

Managing individual panels
You can position each panel individually anywhere in the workspace by
dragging it from its top bar or title tab. You can find additional appearance
options under the panel’s flyout menu, accessible from the icon in its upper-
right (see Figure 1-4). The flyout menu also provides another way of getting
to the panel’s primary tasks.

Figure 1-3:
The fully
contextual
Property
inspector
can show
options for
selected
artwork,
frames on
the timeline,
or tools like
the Pen and
Pencil.
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To dock panels together, simply drag one on top of the other; once docked
together, you can move, minimize, or close several panels as one unit. This is
handy for keeping commonly used or related panels together.

You can save panel and panel positions and groups as part of custom work-
spaces. (See the section “Creating and Saving Workspaces,” later in this
chapter.)

Panels can always be toggled on or off from the Window menu. If you don’t
see a panel or have accidentally closed one, look for it in the Window menu.
Many panels have shortcut keys; if you use a panel often, use its shortcut
key combination for easy access.

Creating and Saving Workspaces
One of the most useful additions in recent versions of Flash is the ability to
save your workspaces, or the appearance and layout of workspace items
such as the Toolbar, Timeline, Property inspector, and panels.

Saving workspaces is essential if you’re sharing a computer workstation with
others and want to recall your favorite panels and setup instantly. However,
it can be useful for maintaining different workspaces for different projects,
even if you’re the only person working on your computer.

To create and save your workspace layout:

1. Open and position any panels or panels you want available, including
the Toolbar, Timeline, and Property inspector.

You can toggle panels and panels on or off from the Window menu.

Minimize
and close.

The double arrows
toggle the group
into icon mode
(right).

Each pane has a fly out
menu with additional
options.

Resize the pane group.

Grab a pane by its tab
to group it (or ungroup
it) with other panes.

Use the lower corner
to resize an individual pane.

Figure 1-4:
Anatomy 
of a panel.
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2. Choose Window➪Workspace➪Save Current.

3. Assign your workspace a new name and click OK.

Your workspace is now available by name under the Workspaces menu.

To recall a workspace, choose Window➪Workspace➪[Your workspace name].
The current workspace rebuilds and appears exactly as you saved it.

You can view all your saved workspaces at any point by choosing Window➪
Workspace➪Manage. From this panel, you can choose to delete or rename
existing workspaces at any point.

The default workspace can’t be modified, deleted, or renamed.

Saving and Opening Documents
It’s always recommended that you save your document after you make any
significant changes or additions, and although not necessary, it’s also a good
idea to save a new document immediately after creating it. To save a docu-
ment, choose File➪Save. Enter a name for your file and choose a location 
on your hard drive to save it to.

To open an existing document, choose File➪Open and locate the FLA file on
your hard drive.

You may need at some point to save a copy of your document under a new
name, either to create an alternate version or perhaps to make it compatible
with an older version of Flash.

To save a copy of your document under a new name, choose File➪Save As.
Choose a location on your hard drive and enter a new filename. The drop-
down menu at the bottom of the Save As dialog box lets you choose what
version of Flash you want to save the file in. From Flash CS3, you can save
files into Flash 8 format as well.

Saving a document in an older version of Flash may make some newer fea-
tures unavailable. Avoid saving your file in an older file format unless you
absolutely need to make it available to an older version of Flash.

Getting to Know Flash Player 9
The Flash Player is at the heart of Flash technology. The player, which you
can find as a plug-in to Web browsers or as a standalone application, runs
and plays completed Flash movies, known as SWF (ShockWave Flash) files.
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Beyond simple playback, the Flash Player is also responsible for deciphering
and carrying out instructions written in ActionScript, Flash’s powerful built-
in scripting language. ActionScript, which is introduced in Chapter 7, gives
your Flash movies many more abilities, including playback control, real-time
user interaction, and complex effects.

Your end user needs the Flash Player in order to view your movies.
Fortunately, at the time of this writing, the Flash Player is in use by 96 per-
cent of Internet-enabled PCs worldwide. If a user doesn’t have the Flash
Player installed, it’s available as a free download from the Adobe Web 
site at www.adobe.com.

Talking about Layers
If you’ve worked with other programs that utilize Layers (such as Photoshop
or Illustrator), the concept is very much the same. If you’re new to layers, it’s
best to think of them as clear pieces of film stacked on top of each other.
Each layer can contain its own artwork and animations.

In Flash, you use layers to stack artwork and animations on the stage, allow-
ing them to exist together visually but to be edited or moved independently
from one another. You can reorder layers to position artwork in front of or
behind artwork on other layers.

To create a new layer, click the New Layer icon at the bottom of the timeline.
The layer is automatically assigned a name; you can rename any layer by
double-clicking its name and typing a new name.

The Flash Player: New and improved for CS3!
If you’ve used previous versions of Flash and
the Flash Player, it’s worth mentioning some
significant improvements in Flash Player 9.

� For the speed demons out there: Flash
Player 9 can achieve up to 10 times faster
performance than its predecessor, thanks
to improvements and revisions in Action
Script 3.0, as well as the new ActionScript
Virtual Machine 2 (VM2).

� Behind the times? Don’t worry — Flash
Player 9 features a second ActionScript
Virtual Machine (VM1) side by side with

VM2, dedicated strictly to handling the
golden oldies (ActionScript Versions 1.0
and 2.0).

� Don’t let the debugs bite: Improved debug-
ging and error reporting means trouble-
shooting is easier and more intuitive. If
something doesn’t go quite right during
playback of your movie, error reports
appear. Previously, the Flash Player 
handled runtime errors gracefully, but
silently — very considerate, but not very
useful.
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To delete a layer:

1. In the Timeline window above the stage, select the layer you want to
delete.

Hold down the Shift key to select multiple layers. You can then click the
Trash icon to delete all the selected layers at once.

2. Click the Delete Layer icon below the timeline.

The beauty of working with layers is that you can easily change the stacking
order and appearance of artwork and animations distributed across those
layers. To reorder layers, simply select a layer by clicking its label on the
timeline and then click and drag the layer up or down in the stacking order
and release it to its new position (see Figure 1-5). Layers at the top of the list
will appear in front of other objects in lower layers; in contrast, layers at the
bottom of the list will appear below or behind items on higher layers.

Two additional aspects of managing layers include toggling a layer and its
contents visible or invisible, and locking layers to prevent their contents
from being accidentally moved or modified.

To toggle a layer’s visibility on or off, click any layer in the column below the
Visibility icon. To toggle all layers on or off, click the Eye icon at the top of
the column.

To prevent layer contents from being modified, click any layer in the column
below the Padlock. To unlock it, click the Padlock again. To lock or unlock all
layers, click the Padlock icon at the top of the column.

Locking layers ensures that you won’t accidentally move or delete the art-
work it contains. Make a habit of locking layers whenever you’re not working
with them.

Layer visibility only affects what you see inside of the authoring environ-
ment and has no effect on the finished SWF file. Layers whose visibility is
toggled off in your document will still appear when published.

Figure 1-5:
It’s easy to
shuffle
layers —
just click
and drag 
to reorder
any layer.
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Importing Files
There will be times when you need to bring resources — such as artwork or
photo files created in Adobe Photoshop or Illustrator, .MP3 sound files, and
even video files — that were not created in Flash. You can import the follow-
ing file formats into Flash:

✦ JPEG, GIF and PNG, TIFF, EPS

✦ Flash SWF Files

✦ Adobe Illustrator (.ai) and Photoshop (.psd)

✦ AIFF, WAV, and MP3 audio files

✦ MPEG, MOV, QuickTime, and FLV video formats (Import Video only)

You can import these files directly to the stage for immediate use or to your
document’s Library (see Chapter 2 of this minibook) for storage until you’re
ready to place them on the stage.

To import files to the stage:

1. Choose File➪Import➪Import To Stage.

2. Select the file(s) from your hard drive that you want to import.

Imported items are placed on the stage on the currently selected layer
and frame.

To import files directly to the Library:

1. Choose File➪Import➪Import To Library.

2. Select the files from your hard drive that you want to import and click
the Open button.

Imported files don’t appear on the stage, but are available in the Library
panel for use later on.

To select multiple files for import, hold down the Shift key when prompted
to select files from your hard drive. You’ll be able to bring several files to the
Stage or Library in one step.

Exporting Files from Flash
In contrast to the Import menu, the Export menu is used to generate files
from your current document out of Flash, most often to create a compressed
SWF file for final publishing. Additionally, it can be used to generate static
images (such as a JPEGs or GIFs) from specific frames in your movie.
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Publishing Your Final Movie
The final step in getting your movie ready to be posted on the Web, distrib-
uted on a CD-ROM, or sent through e-mail is the publishing process. The pub-
lishing process handles two important tasks: Exporting the final SWF file
playable by the Flash Player, and creating any additional files (such as Web
pages) necessary to display your movie. The File menu’s Publish Settings
and Publish options handle the setup and publishing of your movie so that
you can show the world your new creation.

Flash can create any and all of the following file types at Publish time:

✦ SWF files

✦ JPG, GIF, or PNG bitmap files

✦ Projector files

If you want to distribute your movie as a standalone file, you can create
a Mac or PC compatible projector that includes the Flash player.

✦ HTML files

To display your movies on the Web, you’ll need to contain it within a
Web page, or HTML file. Flash takes care of creating this page for you.

✦ QuickTime movies

Chapter 2 of this minibook explores publishing in more detail.

FLA and SWF files
The life of a Flash project involves at least two
different types of files: your authoring file (FLA)
in which all your work is created, and the final
product: your compressed movie or SWF file.

FLA files work only within the Flash CS3 appli-
cation (the authoring environment). When
you’re ready to distribute your finished movie,
you’ll need to publish an SWF file that can be
played back by the Flash Player.

These SWF files can be created from the
Publish or Export menu options and are 

compressed movie files (typically smaller than
their .FLA counterparts) that contain all the
graphics and information necessary to display
your movie.

The Flash Player can’t read FLA files, and SWF
files can’t be deconstructed into usable FLA
files. Changes to your Flash movie are always
done in the original FLA file and must be re-
exported to a new SWF file if you want to view
them in the Flash Player.
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